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activa Art
4	� Create your own art using any BERNINA® sewing machine, even the simple activa 

models. But, don’t forget - these great pieces can be made using any BERNINA®  
sewing machine, even an artista!

Butterfly Dreams
7	� What better gift to give your friend than a spa treatment in a box? Choose one of 

OESD’s Dream Keeper boxes to decorate and fill with lotions and potions sure to 
please any recipient.

Pillow Party
10	� Elegant, fun, quick, and easy! Three pillow projects that will excite your spirit with an 

instant sense of accomplishment.

French Ribbon Rose Brooch
14	� Make a simple ribbon rose brooch using French wired ribbons and easy hand-stitch-

ing, and then pin it on your favorite jacket, hat or purse. Tres chic!

Digitizing 101 – Part 2
16	� Continue the learning process of digitizing your own designs. Master digitizer, Debbi 

Lashbrook takes you through stitch order, color, and refining designs in the second 
article of this 3-part series.

Sassy Skirt… The Wearable Answer to the T-shirt Quilt
20	� Make a fun skirt from your stash of t-shirts. This is the type of project that makes 

sewing cool!

Waiting for Sunset
22	�T his beautiful quilt uses a traditional block, Drunkard’s Path, in a contemporary way. 

The modern Bali Batiks, the random setting, appliquéd rectangles, and quilting in 
the machine embroidery hoop all work together to make this stunning study of warm 
colors playful and soothing at the same time.

Incomparable Quilts!
25	� Learn to love your fiber creations and quit comparing them to others. Let them stand 

on their own for the joy and satisfaction they bring.

Fantasia Floral Hanging
26	�T his simple wall hanging features a needle punched floral design using a variety of 

decorative fibers and is framed by curved borders.

Baltimore Today
28	�T his beautiful quilt of Baltimore Album designs showcases embroidery designs from 

Studio Bernina® Baltimore Elegance Design Collection by Elly Sienkiewicz.

in celebration
30	� See how one BERNINA enthusiast celebrates her love of BERNINA!

Stitch Recipe: elegant tradition
32	� Combine simple piecing, appliqué and a wing needle with the Entredeux stitch to  

create a recipe that can be applied to many projects including home decorating  
projects, garments, craft items, and quilts.

Serpentine Table Runner
34	 Create this linen table runner with decorative stitches and a serpentine border.

in a clutch
36	� See this unique embroidery collection that is more than just decoration! When you 

stitch the “designs” from In A Clutch, you are actually making purses!
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of textile and mixed media art. This has led to her work being featured in 
BERNINA® print advertisements and showcased on the BERNINA® USA 75th 
Anniversary website (www.berninausa.com/75).

Paula Harmon
	� Paula Harmon came to Oklahoma Embroidery Supply and Design from 

Southwest Florida where she taught a variety of classes including  
BERNINA® Software and Machine Mastery. Her love of embroidery software 
has given her the ability to teach many levels of students from beginner to 
advanced with enthusiasm and patience. Paula came to love software after 
purchasing her first machine with a 4” x 4” hoop and is a master design splitter.

Helen Gibb
�A native of Sydney, Australia who now lives in the United States, Helen has 
incredible talents in ribbonwork that are evident throughout the pages of 
her books and on her DVD. Her books are The Secrets of Fashioning Ribbon 
Flowers, Heirloom Ribbonwork, Ribbonwork The Complete Guide, and Elegant 
Ribbonwork. Her DVD is titled Beginners Guide to Ribbonwork.

Debbi Lashbrook
�	� A former teacher at the University level, Debbi also managed the  

BERNINA® Sewing Center in Plano, TX for five years before joining the 
Education staff at BERNINA® of America. Her specialties include garment 
construction, pattern drafting and fitting, and embroidery software.

Vicki Tracy
�Vicki’s unique sense of style and her obvious love of sewing and machine 
embroidery serves her well as the owner of BERNINA® Sewing Studio in 
Lubbock, Texas. Her free-wheeling approach to sewing is evident in her 
personal motto - “Lighten Up. Be Fearless. Have Fun.

Nancy Monson
	� Nancy Monson is a quilter, craft designer, and freelance writer living in 

Shelton, CT. She is the author of Craft to Heal: Soothing Your Soul with  
Sewing, Painting, and Other Pastimes, available at bookstores nationwide  
and online. Visit her website at www.nancymonson.com.”

Edna Gregory
�Edna Gregory, a freelance employee for BERNINA® of America, is a former 
BERNINA®, quilt & fabric shop owner.  She has been sewing since grade 
school, and loves to try creative techniques in sewing, serging, quilting, and 
machine embroidery. Teaching and inspiring creativity is one of her favorite 
activities.

Jane Michals
Jane has been a BERNINA® of America employee for over 19 years. In 2004, 
she and her sister opened a quilt shop, Phat Quarters, in Galena, IL. She 
enjoys sharing her enthusiasm for everything BERNINA® by teaching sewing, 
quilting, machine embroidery and software classes.

Nina McVeigh
�During 14 years of owning her own store, Nina developed and taught her 
original patterns and designs in BERNINA® Clubs and Classes. An avid  
quilter, heirloom sewer and lover of all kinds of embellishment, she is also  
a collector of scissors, buttons and thread.

Roni Gerhardt
A kindergarten teacher, Roni works part-time for The Quilt Shop in Danbury, 
CT and is definitely a BERNINA® enthusiast!
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from bernina®
by susan beck

We all like to think we are fashionable – in our 
dress, the style of our home, the choice of our 
artwork. It’s one of the reasons we sew – so we 
can make up-to-the-minute garments, decorate 
our home in style, and create fabulous fiber art. 
This issue of Through The Needle features several 
projects from a new BERNINA® program called 
“All Things Fashionable”. BERNINA® Educators 
will visit BERNINA® stores across the country and 
share fashionable projects for all types of sewers: 
quilters, garment makers, home dec sewers, crafters and embroiderers.

While reading this issue of Through The Needle, look  
for the “All Things Fashionable” logo to get a glimpse of 

what you’ll see in the class. The wall hanging, Waiting for 
Sunset, on page 22 is a great example of how  
fashionable a few colorful fabrics and some simple  
techniques can be. And the pillows on page 10 are fun and 
festive enough for a party! So visit the BERNINA® USA 
website (www.berninausa.com) to see if the “All Things 
Fashionable” program is coming to your area - don’t miss 
the latest fun techniques and inspirational ideas from 
BERNINA®!

In addition to the “All 
Things Fashionable” projects, you’ll find other ideas to 

get you sewing! If you have so many T-shirts you can’t wear them 
all, take a few and make a skirt! See Sassy Skirt on page 20 for 
Vicki Tracy’s easy steps to turn your Tees into a funky new addi-
tion to your wardrobe. The beautiful Rose Brooch on page 14 
is made of wire-edged ribbons and can be created in just 
a few minutes of artistic activity. On page 28, you’ll find 
Baltimore Today, a rich looking embroidered quilt featur-
ing Baltimore Album designs, giving an    updated look 
to a traditional favorite.

The 75th Anniversary of the BERNINA® brand continues 
and on page 31 one BERNINA® enthusiast shares how she 
celebrates her love of BERNINA® machines every day!

So no matter what you think is fashionable, get creative and sew something!
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activa Art 210
By Lori Brocesky

Create your own art using any BERNINA®  
sewing machine, even the simple activa 
models. The activa model 210 offers the same legendary Swiss precision, high-quality 
standards, and gorgeous stitching you find on all BERNINA® machines! Look for  
step-by-step directions for companion art pieces made with the activa models 220, 230PE, 
and 240 on the BERNINA® USA website (www.berninausa.com > sewing studio > free  
projects). Remember, these great pieces can be made using any BERNINA® sewing  
machine, even an artista!



Drawing is for reference only and is not to scale

Paint the Table Napkins
1. �Dilute paints in separate containers with approximately equal 

parts water.

2. �Wet table napkins and squeeze out excess water. Lay flat on a 
protected surface.

3. �Use the foam paintbrushes to apply paint to the napkins,  
allowing the colors to remain separate in some areas and to 
flow into each other in other areas.

4. �Leave napkins to dry and heat-set the paint according to  
product directions.

Create Burned Red Accent Pieces
1. �Cut the assorted scraps of sheer, lightweight polyester fabrics 

and tissue lame into bits approximately ½” square, striving for 
random shapes and sizes.

2. �Make a “fabric sandwich” by sprinkling bits on top of the 7” wool 
layer. Cover the polyester bits on top of the wool with the 7” 
square of red chiffon/organza. Secure layers with straight pins.

3. �Thread the stitch-finger on the bobbin case to ensure that  
the bobbin thread will not show on the top of the art square. 
Keep stitch finger threaded throughout embellishment and 
construction.

4. �Use the Madeira red rayon embroidery thread, embroidery needle, Open Embroidery Foot #20 and straight stitch #1 on the machine to 
stitch a diagonal grid across the fabric sandwich. Use the edge of the presser foot to equally space the stitching lines.

5. �With the wood-burning tool, lightly burn through the red chiffon/organza layer, exposing the bits of polyester fabrics and lamès in the 
fabric sandwich. Choose random squares formed by the straight stitching for burning. Note: The burning process should take place 
outdoors and the use of a mask or respirator is recommended.

6. �Cut the burned fabric sandwich into the following size pieces: Four strips, ¾” x 6½” and one 3¼” square

Stitch Burned Red Accent Pieces to Purple Dupioni Square
1. �Use the temporary spray adhesive to attach stabilizer to the back of the purple dupioni.

2. �Layer 2 of the strips of red burned fabric on top of the dupioni so that the long sides of the strips are parallel to and ½” inside the side 
edges of the dupioni, using spray adhesive to hold in place. The short ends of the burned strips should be even with the top and bottom 
edges of the dupioni. (Refer to art square diagram for placement guidance.).

3. �Zigzag stitch along the 2 long edges of each strip with Yenmet gold metallic thread.

4. �Use the temporary spray adhesive to layer the remaining strips of the red burned fabric on top of the dupioni so that the long sides of the 
strips are parallel to and ½” inside the top and bottom edges of the dupioni. The short ends of the strips should be even with the side 
edges of the dupioni.

5. �Again, use the Yenmet gold metallic thread to zigzag stitch along the 2 long edges of each strip.

6. �Attach the 3¼” square of red burned fabric in the center of the dupioni, using spray adhesive to hold in place.

7. �Zigzag stitch with the gold thread around all 4 sides of the burned square, securing it to the dupioni.

8. Tear away the excess stabilizer from the back of the dupioni.

Stitch Purple Dupioni Square to Painted Table Napkin Background
1. Once the table napkins are dry, attach the 9” square of craft felt to the back of one of the napkins with temporary spray adhesive.

2. Use temporary spray adhesive to attach the dupioni to the center of the napkin backed with felt.

3. Zigzag stitch around all 4 sides of the dupioni with purple Isacord thread, securing it to the painted napkin background.

4. Trim both painted napkins to 8” square.

ISSUE 23
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activa Art 210 Instructions
Note: Refer to the photo on the previous page to see completed visuals of the techniques detailed here.
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Embellish the Art Square
1. Add seed stitches by machine to the painted napkin background in the following manner:
 	 a. �Thread machine with pink Isacord thread and adjust for a 5.5mm wide zigzag stitch; lower the feed dogs.
 	 b. �Apply zigzag stitches randomly to the painted napkin background, allowing the needle to swing from side to side about 10-12 

times to build-up thread for each of the seed stitches. Lift the presser foot, move and rotate the fabric and create another seed 
stitch at a different angle. Continue creating seed stitches, moving and rotating the fabric with each stitch.

	 c. �Adjust the machine for a 4mm wide zigzag stitch; continue in the manner above, randomly creating the narrower seed stitches 
interspersed among the wider seed stitches.

 	 d. Draw all thread tails to the back of the piece and tie off.

2. Randomly stitch beads on top of the silk dupioni by hand or machine.

3. �Grasp one corner of a 2” purple chiffon square allowing the other 3 corners to drape down. Position the chiffon near the top of the red 
burned square in the center of the dupioni with the top corner of the chiffon extending approximately 1” above the top of the burned 
square. Secure to the art square with purple Isacord thread and zigzag stitches with the feed dogs lowered. Draw the thread tails to the 
back of the art square and tie off.

4. Fold each of the wire pieces in half. Wrap the ends of the wire, one at a time, around the needle nose pliers, creating spirals.

5. �Referring to the art square example for placement, position the folded end of each wire on top of a chiffon square and secure with  
zigzag stitches with feed dogs lowered. Stitch slowly and ensure that the needle will swing wide enough to clear the wire. Increase the 
stitch width if the needle does not clear the wire on each side. Draw thread tails to the back of the art and tie off.

6. Stitch the buttons on top of the wire by hand, adding 3 small beads to the top of each button with the last stitch.

Back the Art Square and Finish Outer Edges
1. Attach the remaining table napkin to the back of the art square with temporary spray adhesive.

2. Randomly tie knots in the rattail cord.

3. �Attach Bulky Overlock Foot #12 to the machine and re-thread with purple Isacord thread if you have changed thread colors. Raise the 
feed dogs.

4. �Lay the knotted rattail cord along the lower edge of the art square and position the art square under Foot #12 with the cord centered  
under the groove of the foot and the art square extending to the left of the foot. Allow approximately 3” of un-knotted cord to extend 
behind the foot.

5. �Zigzag stitch, securing the cord to the edge of the art square. Adjust the stitch width so that the left swing of the needle stitches into  
the art square while the right swing of the needle stitches into the cord. Stop stitching as the foot approaches each knot in the cord. 
Reposition the art square and cord under the foot past the knot and resume stitching. Stitch all the way around the art square to secure 
the cord to the edge.

6. �Stop stitching approximately 1” ahead of the beginning stitches. Remove the art square and cord from the machine. Tie the cord tails in  
a knot to join. Wrap the cord tails to the back of the art square and secure with hand stitches. Trim excess cord if necessary.

Supplies

• �2 linen or linen/rayon Damask table napkins, approximately  
9” square each

• 6½” square of purple Silk Dupioni

• �7” square lightweight wool, such as flannel or crepe

• �Assorted scraps of sheer, lightweight polyester, such as  
chiffon and/or organza in pinks, reds and purples

• �Bits of tissue lamè in metallic silver, gold and purple

• �7” square red polyester chiffon or organza

• �Three 2” squares purple polyester chiffon

• 9” square of purple craft felt

• �6½” square of Stitch and Tear stabilizer

• �Pink and purple Pebeo Setacolor transparent fabric paints

• Containers to mix paint

• Foam paint brushes

• Machine Embroidery Needle Size 90

• Open Embroidery Foot #20

• Bulky Overlock Foot #12

• Madeira Red Rayon Embroidery Thread

• Purple Isacord Embroidery Thread

• Pink Isacord Embroidery Thread

• Gold Yenmet Metallic Thread

• 3 decorative buttons

• �2 yards purple rattail cord (also known as satin cord)

• Assorted glass beads in pinks and reds

• �Three pieces of 20 gauge brass wire – 10” long each

• Needle nose pliers

• Wood-burning tool

• Hand-sewing needle

• HRFive temporary spray adhesive 



Planning and Stitching the Embroidery
eXplorations software is the perfect place to “audition” your designs 
to decide which embroidery you want on the box. 

1. �Open the eXplorations program and create a new project.

2. �From the Articles Mode, select the Utility Shapes Folder. Locate 
the shape that best resembles the cover of your box. In this 
example, the rectangle was used.  

3. �Locate the top of the Dream Keeper box (each piece will have 
a letter on it and is listed in the instructions to show where it 
belongs in the box).

4. �Measure the top of the box and put the measurements (width 
and height) in the corresponding boxes in the software. Click 
Apply.

by Paula Harmon

Dream Keeper BoX - 

What better gift to give your friend 

than a spa treatment in a box? 

Choose one of OESD’s Dream 

Keeper boxes to decorate and fill 

with lotions and potions sure to  

please any recipient. 

THROUGH THE NEEDLE
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5. �Next, select the Fabrics mode. This allows you to see the designs 
on the fabric you’ve selected. eXplorations has several fabric 
catalogs and solid colors from which to choose; you can also 
scan fabric into the software. For this sample, fabric from  
Benartex > Apple Butter was selected.

6. �Using Filing Assistant, drag and drop designs onto your article, 
arranging them in a pleasing manner. This is a great opportunity 
to use all those options – Layout Wheel, Appliqué, Color Wheel, 
Lettering and more. 

7. �Because this particular box has a cover that is larger than most 
machine hoops can accommodate, use the Multi Hooping option 
to break the design down into parts for this project. 

8. �In the Hoops mode in eXplorations, you will place hoops over the 
design until each object has turned green (if any objects are still 
black, you have not covered all objects with a hoop).

              

9.   Click on Calculate Hoopings to see how many hoopings this  
layout will need. There may be times where you only place 2 
hoops on the screen but because of the way the design has  
been digitized, it might require more hoopings in order to keep 
the dimensions correct.

10. �Use the Connect Mode to send the split files to your machine.

11. �Stitch the first part of the design on the base fabric. The last 
thing that sews on this design is a set of registration marks. 
When the design is complete, remove the fabric from the hoop 
and gently remove all of the stabilizer from the back of the de-
sign, making sure that you do not disturb the registration marks. 
Hint: If you are concerned about your registration marks, simply 
trace them using a water-soluble marker.

12. �Hoop a single layer of OESD 
Stabil-Stick Stabilizer (ei-
ther cut away or tear away, 
depending on whether or not 
your fabric stretches); hoop 
with the shiny side up. Using a 
sharp object, score the paper 
within the hoop and remove.

13. �Now sew the registration 
marks in the second hooping. 
Take your hoop (without fabric) 
with the Stabil-Stick to your 
embroidery machine. Place 
the hoop on your machine and 
stitch the first color of the second hooping.

14. �This is where the magic happens. Align the registration marks 
from hooping #1 (fabric) with the registration marks from hoop-
ing #2 (stabilizer). It is a good idea to use a padded surface with 
a grid to help keep your fabric straight. Place the hoop on the 
padded surface. Place a straight pin through the registration 
mark from hooping number 1 (being sure to be in the center of 
the “X”) and then put the pin through the corresponding “X” in 
hooping 2. Repeat with all subsequent registration marks. 

15. �Once all of the registration marks are aligned, carefully smooth 
the remaining fabric in the hoop.

16. �Carefully return the hoop to the machine after removing  
the pins and continue to stitch hooping 2 until finished.  
Repeat these steps until all designs have been stitched. 

Completing The Dream Keeper
Cover the Dream Keeper with the embroidered fabric and finish it by 
following the manufacturers instructions found in the packaging.

THROUGH THE NEEDLE
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Spa SlipperS
I love to take “regular designs” and make 
them do tricks whenever possible. This 
collection by Deb Strain has provided  
several options. Use eXplorations software 
to create 3 dimensional butterflies.

1. �Open eXplora-
tions and create 
a new project. 

2. �Using Filing  
Assistant, 
locate design 
CC84348 and 
drag it onto the 
work area. This 
particular de-
sign is perfect 
for this tech-
nique because 
of the way it 
stitches. This 
will become 
clearer as we 
go on. 

3. �Using Edit and Duplicate, create a second butterfly on the screen. 
Leave plenty of space between the butterflies so they do not 
overlap. The way this design stitches as it is now results in 14 
color changes. If you would like to combine colors, click on Tools 
and Stitch Sequence to minimize the number of thread changes. 

4. �Ungroup the but-
terflies and delete 
all of the colors 
associated with 
the body (in this 
example, it will be 
the last 3 colors 
of the design). 
Once the body 
has been deleted, 
resize your design 
to 85% of its origi-
nal size. The wing 
sets just created 
will be the dimen-
sional part of the  
embroidery. Send 
this creation to 
the embroidery 
machine and 
stitch on two layers of white PolyMesh stabilizer by OESD. Keep 
in mind that these butterflies will be dimensional and you may 
see the “under” side of the embroidery so use bobbin thread that 
matches the blue that makes up most of the butterfly. When you 
see the design from the bottom, it all blends together. 

5. �Using small 
sharp scis-
sors, trim 
around the 
outer edge 
of each of 
the butter-
flies created 
above. Do not 
separate the 
wings.

6. �When trim-
ming away 
the excess 
PolyMesh 
stabilizer there 
may be some 
white areas left 
after trimming 
because you 
could not get 
any closer 
without clip-
ping (damag-
ing) the embroidery thread. There are two options to handle this 
problem: one is to use a wood burning tool to “melt” away the left 
over stabilizer or because the outline is black, you can simply use 
a black permanent marker to color the white away.

7. �Next, create two more butterflies that will be the under wings and 
the body of the design. Place two more CC84348 designs in the 
hoop remembering to leave some room between the designs.

8. �In the last hooping, the Stitch Sequence command was used to 
keep the color changes to a minimum. In this hooping, I would rec-
ommend that you not use Stitch Sequence unless you are a very 
experienced embroiderer since we will be stitching these two parts 
of the butterfly together when the body stitches out in hoop #2. 

9. �Send the created 
second hoop to your 
machine and stitch all  
of the embroidery 
colors on two layers 
of PolyMesh stabi-
lizer making sure to 
stop when you get 
to the body (color 
#5). Place the wings 
created in the steps 
above over the wings 
that are stitching in 
hooping #2. Hold 
in place and stitch 
color #6 (the butterfly body). Note: Be very careful not to get your 
fingers in the way of the needle. Repeat this step with the second 
butterfly to finish the pair. Trim away the excess PolyMesh the 
same as on the first set of wings. 

10. �Glue or hand stitch the butterflies onto the spa slippers to  
complete your gift. 

ISSUE 23
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Elegant, fun, quick, and easy!! 
Three pillow projects that will excite your spirit 

with an instant sense of accomplishment. The three slip 
covers and pillow wraps can be easily interchanged for versatility.

By Kristie Smith

General Supplies (for all three pillows)
• �Pattern: Itís a Wrap! ...pillow sleeves! 

From Vanilla House Designs
• �Mettler sewing thread to match fabrics 

and trims
• �16” pillow forms (3 total)
• �Silk adaptations (sweet) by Mary Jo 

Hiney Designs
• �Weeks Dye Works Hand Dyed Wool 

fat quarters (Kohl #3900)
• �Armo Weft® fusible interfacing (2½ 

yards total)
• �Nifty Notions appliqué scissors

Supplies for Finishing Pillows
• �Edgestitch Foot #10/10C
• �Double Cord Foot #59C
• �Piping Foot #38
• �Automatic Buttonhole Foot #3A
• �Button Sew-On Foot #18
• �Flat Buttons (2 per pillow)
• �EZ Glitzer® and Glitzing Stones 

(optional)

Slipcover Pillow Wrap Supplies
• �½ yard fabric or 2 fat quarters (fabrics 

used for samples: Janelle by Marianne   
                      Elizabeth for Benartex)

• �Patchwork Foot with 
Guide #57

• �Serger (optional)
• �Overlock Foot #2/2A 

(optional)
• �6mm Zigzag Hemmer 

Foot #66

10



Making the Slipcover
Cut and assemble slipcover as per pattern. Use Patchwork Foot 
with Guide #57 for consistent ¼”  seams. Finish seams with a 
3 thread narrow overlock on the serger or overlock stitch on 
the sewing machine (Overlock stitch #10 on artista 730). Note: 
Remember to use foot #2/2A if using an overlock stitch on the 
sewing machine.

Attach 6mm Zigzag 
Hemmer Foot #66 
and to the machine 
and select Zigzag 
Stitch #2. Move 
needle position to 
half right, load fabric 
into foot, and stitch 
around open raw 
edge of pillow cover 
to hem the edge of 
the open side of the 
slipcover.

Turn the slipcover right side out, press, and insert pillow form. To 
complete the pillow, create a wrap of your choice using directions 
on the following pages.

Pillow Wrap 1: Curve Appeal
Supplies: 
  • �Shiva Artist Paintstiks (Romance  

Mini Set of 3)
  • �Cedar Canyon rubbing plates  

(Curves)
  • �Paintstiks on Fabric Book by  

Shelly Stokes
  • �5/8 yard of coordinating fabric for  

wrap completion
  • �½ yard 6mm cording 
  • Wax paper
  • Masking tape
  • Circular Embroidery Attachment #83
  • Clear foot #34/34C
  • Isacord thread (#3600)
  • Ultra Clean and Tear stabilizer
  • Cording Foot #22 
  • �YLI Designer 6 thread (#205 Fuchsia, #335 Iced green, #904 Aqua)
  • Buttons (2 for tabs, 3 for embellishment= 5 total)
  • Button Sew-On Foot #18

Preparation for 
Paintstiks: 
Place rubbing 
plates onto a 
flat work surface 
and align plates 
adjacent to 
each other in 
two rows. Use 
masking tape to 
secure plates to 
the table. Cover 
the rubbing 
plates with wax 

paper and secure to the table with tape. Cut one 14” x 18” piece of 
fabric to paint. Cover wax paper with fabric and tape to secure into 
place.

Painting the 
Fabric: 
Remove 
film from 
Paintstiks and 
paint fabric 
in a curved 
motion to 
create a 
textured 
design. Allow 
fabric to dry 
3-5 days. 

Decorative Appliqué: 
Fuse Armo Weft® interfacing to the wrong side of the fabric per 
manufacturer’s recommendations. Attach the Circular Embroidery 
Attachment to the machine (move pin to notch #3), attach Clear 
Foot #34/34C, thread with Isacord thread. Place a piece of Ultra 
clean and Tear stabilizer behind the painted fabric, and place on 
pin of the Circular Embroidery Attachment. Place a 4” square of silk 
on the pin and on top of the fabric. Stitch a straight stitch around 
the circle to 
secure the 
silk. With 
appliqué 
scissors, trim 
the excess 
silk from 
around the 
outside of the 
circle. Tip: If 
you take the 
fabric off the 
pin to cut the 
fabric, mark 
the center with marking pen for easy replacement.

Attach Cording 
Foot #22. Cut 
about 1 yd of 
each color of 
Designer 6 
thread, and 
tie in a knot 
on one end 
to secure the 
three threads 
together. 
Load threads 
into Foot 
#22, placing 
them in the 
corresponding 

grooves on the foot. Chose any decorative stitch and sew around 
the circle. The foot facilitates couching of the cords/threads while 
sewing a decorative stitch. Tip: Any decorative stitch will work 
well, but I prefer open stitches to better show decorative threads. 
Examples are Serpentine and Honeycomb. 

Sew buttons onto circles for embellishment using the Button  
Sew-on Foot #18 and the Button sew-on stitch built into Bernina® 
machines.

Trim fabric to 13” X 17” (this is the front of the pillow sleeve).

Refer to finishing instructions to complete pillow wrap. 
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Pillow Wrap 2: Exquisitely Quilted for a Queen
Supplies: 
  • �Silk adaptations (sweet) by  

Mary Jo Hiney Designs
  • �Patchwork Foot with Guide #57
  • �5/8 yard of coordinating fabric  

for wrap completion
  • ½ yard tasseled trim
  • ½ yard 6mm cording
  • Cotton batting (14” x 18”)
  • Large oval hoop
  • Embroidery machine
  • PolyMesh stabilizer
  • �HRFive temporary adhesive spray
  • V.5 BERNINA® Embroidery Software - DesignerPlus
  • 75/11 Organ embroidery needle
  • Isacord thread (colors 1921 and 5934)
  • �Wool scraps from Weeks Dye Works Hand Dyed Wool fat 

quarters (3” square, 5” square)
  • YLI silk thread #100 (color 242)
  • 60/8 Universal needle
  • Buttons (2) 
  • BERNINA Stitch Regulator #42 (BSR)

Piecing: 
Cut 4 squares of silk into 9¼” x 7¼” pieces. Tip: Save scraps of silk 
for needlepunching Pillow Wrap #3. Attach Patchwork Foot with 
Guide #57 to the machine and select a straight stitch. With right 
sides together, stitch two pieces of fabric together down the long 
edge; do the same with the other two pieces of fabric. Press seam 
allowances to one side. Align pieced fabric, right sides together at 
short ends; stitch ¼” seam to form a four-patch. Press seams to one 
side. Pieced fabric should measure 14” x 18”. Adhere batting to the 
back of the four-patch fabric with HR5 temporary adhesive spray.

Appliqué Design: 
Open BERNINA® V5 DesignerPlus software and chose the large 
oval hoop. Scan a flower petal or design your own. Select the 
open object tool, single outline stitch, and digitize the petal; enter. 
Select the petal (it will be magenta) and select the wreath tool with 
five multiples. Move the curser until the petals overlap slightly and 
conform into a flower. The software will ask the question “Do you 
want to merge overlapped objects?” Choose “no”; the design will 
now be a closed object. Note: Be sure that the petals overlap. If they 
do not overlap, the appliqué tool will not show the grid fill. Select the 
entire design and change the outline stitch to a stem stitch. 

With the design still selected, select the advanced appliqué tool. 
The design should have a grid inside the closed lines; it is now 
an appliqué. Fabric can be placed within the appliqué and the 
software has automatically selected three distinct thread colors for 
placement, cutting line, and tackdown for appliqué.

To create the center spiro-graph, digitize a rectangle with the 
rectangle tool. With the rectangle selected, right click to open the 
Object Properties box. Select the general tab and change the width 
to 13mm, and the height to 15mm. Select the wreath tool with 18 
multiples; arrange until rectangles are overlapped, forming a spiro-
graph. Position the spiro-graph over the center of the flower. 

Select the entire design; right click and drag to quick-clone the 
design. Increase the second design 20% and rotate slightly. Place 
designs at opposite ends of the hoop. Save and send to the 

machine.
Hoop the 
four-patch 
fabric/batting 
with PolyMesh 
stabilizer 
within a large 
hoop. Insert 
an embroidery 
needle into 
machine and 
thread with 
Isacord thread. 
Position the design and stitch on the hooped fabric. Apply wool into 
appliqué design. Remove excess stabilizer. Tip: Appliqué scissors 
work well for stabilizer removal. 

Attach the 
BERNINA® Stitch 
Regulator #42 to 
the sewing machine, 
insert a #60 needle, 
and thread with YLI 
#100 silk thread. 
Freemotion quilt over 
the entire piece. Trim 
fabric to 13” x 17” 
(this is the front of 
the pillow sleeve.) 

Refer to finishing instructions to complete pillow wrap. 

Pillow Wrap 3: Mosaically Challenged
Supplies: 
  • �Silk scraps from Silk adaptations  

(sweet) by Mary Jo Hiney Designs
  • �Weeks Dye Works Hand Dyed  

Wool fat quarters - 14” x 18” 
  • �BERNINA® Needle Punch  

Accessory Set
  • �Armo Weft® interfacing 
  • �BERNINA® Stitch Regulator #42
  • �YLI Designer 6 (ice green,  

#335)
  • �Extra bobbin case (black latch                                                    

 if available for your machine)
  • �80/12 Universal needle
  • �5/8 yard of coordinating fabric for wrap completion
  • �½ yard tasseled trim
  • �Mettler Metrosene plus (black) 
  • �Ultra Clean and Tear stabilizer (optional)
  • �Buttons (2)
  • �Reference DVD: Bobbin Play with Bonnie 
	  
Needlepunch: 
Attach the Needle Punch Accessory Set to the machine according 
to the instructions included with it. Cut the silk scraps into 2” 
squares and then sub-cut on the diagonal to form triangles. 
Needlepunch silk pieces randomly into wool. To form the flower: 
Arrange the triangles as petals and fill in the center of the flower with 
excess silk. 

Fuse Armo Weft® to the back of the wool following manufacturer’s 
recommendations.
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Bobbin Play: 
Wind Designer 6 thread onto a bobbin. Insert the filled bobbin into 
the separate bobbin case (Do not use bobbin case that came with 
your machine; tension should be adjusted in the additional bobbin 
case only.) Adjust the tension by turning the screw on the side of the 
case quarter turns, with a screw driver, until the thread falls freely 
with a slight drag of tension. Attach the BERNINA® Stitch Regulator 
#42 to the machine, thread the top thread guide with Mettler thread 
and Designer 6 in the adjusted bobbin case. Select straight stitch 
BSR and adjust the stitch length to 4.0 mm. From the back of the 
wool (interfacing side up), meander loosely over the entire piece of 
fabric. When finished stitching, gently remove the stabilizer.

Trim piece of wool to 13” x 17” (this is the front of the pillow sleeve). 

Refer to finishing instructions to complete pillow wrap. 

Finishing Instructions:
Cut a 13” x 17” piece of fabric for the back of the pillow wrap and 
set aside.

Block fuse the fabric for the sleeve tabs and the facings with Armo 
Weft® interfacing to the wrong side; cut pieces as directed.

Assemble the tabs as instructed, then turn and press. Attach 
Edgestitch Foot #10/10C, move the needle position to the far left, 
and edgestitch around the tabs. Attach Patchwork Foot with Guide 
#57, touch the clear button to move needle position to needle 
center, and assemble facings to both the front and back panels as 
directed per pattern.

Trim for 
Pillow #1: 
(Decorative 
cording) Attach 
Double Cord 
Foot #59C to 
the machine, 
select a 
featherstitch, 
and thread the 
machine with 
thread that 
matches the 
cording. Open 
the facing from 

the pillow front and lay flat. Align the cording in the left groove of 
the foot and stitch with the center of the foot along the seam line. 
Stitching will 
catch and 
couch the 
cording to the 
pillow. 

Trim for 
Pillow #2: 
(Tasseled trim 
and decorative 
cording) Attach 
tasseled fringe 
as in #3 (see 
right). Place 
cording on 

top of the fringe. Attach #59C foot to the machine and select the 
blind stitch (#9 on artista 730); alter the stitch length to 4.0mm 
and move the needle position to far left. Insert the cording into left 
groove on the foot and couch cording on top of the fringe. 

Trim for 
Pillow #3: 
(Tasseled trim) 
Attach Piping 
Foot #38 to 
the machine, 
select a 
straight 
stitch, and 
thread with 
coordinating 
thread. Place 
trim onto one 
long edge 
of the fabric, 

right side up; pin if necessary. Place the fabric with trim under the 
foot and stitch to secure trim. 

Assembly: 
With right sides together, assemble pillow wrap front and back 
using the Patchwork Foot with Guide #57, as directed in pattern. 
Finish seams as desired. Turn facing inward, attach Edgestitch Foot 
#10/10C to the sewing machine, center the foot with the guide over 
each seam, and stitch in the ditch to secure the facing. Move the 
needle position to the far left; engage the Long Stitch function if 
available, and edgestitch around the facing.

Buttonholes: 
Instead of sewing buttonholes onto the tabs, the buttonholes will be 
placed onto the pillow wrap front or front facing to not disrupt the 
beauty of the trims. Mark desired placement of buttonholes. Attach 
the Automatic Buttonhole Foot #3A to the machine and choose a 
buttonhole type and size. Note: if using an artista 730, Creative 
Consultant can help you choose the correct buttonhole according 
to the fabric. You can also take advantage of the button measuring 
feature to set buttonhole length. Stitch buttonholes. Sew buttons 
onto tabs using the Button Sew-on Foot #18 and the Button  
Sew-On stitch.

Optional: 
Embellish with the EZ Glitzer® and glitzing stones.

Insert covered pillow form into the pillow wrap and button closed.
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Creating the Rose
The rose is made using a gathered and coiled technique and one yard 
of 1½” wide wire edge ribbon. 
1. �To begin, decide which color edge you want to emphasize on your 

rose, and remove the wire from the opposite edge. You will be 
gathering along this edge and it makes a nicer gather if the wire is 
removed. 

2. �Make a tight cylinder shape for the center of the rose by folding 
down the right end of the ribbon, folding the ribbon across on itself 
and then rolling it into a cylinder shape.

3. �Secure the cylinder with four backstitches to keep it from 
unrolling. Do not cut thread. Sew gathering stitches, about 
¼” long, near the edge of the ribbon, and then up the short 
cut side of the ribbon.

4.� Gently gather the ribbon 
to about a third of its 
original length but don’t 
secure the gathering 
just yet. 

by Helen Gibb

Ribbonwork Notes
• �Use a single thread for stitching. A length of 20” or so is 

best as the thread is short enough to work quickly and is 
least likely to get a knot.

• �Leave a good “return” on the thread after it has been 
threaded through the eye of the needle - enough so it can 
be caught in the crook of your little finger when sewing - 
and won’t pull out of the needle every time you take a stitch. 
You will waste a bit of thread doing this but the frustration of 
losing your thread is greatly diminished.

• �Use backstitches to begin and end all gathering, rather than 
a knot. A knot won’t hold the tight gathering that is often 
required in ribbonwork. Scoop up a little bit of ribbon onto 
your needle, pull the thread through and leave a tiny thread 
tail – ½” is fine. Repeat the stitch in the same spot three 
more times. Gently tug on the thread to be sure it will hold. 
Now you can proceed with the running stitch or whatever 
task is required. When you have finished the required 
technique, and the ribbon is gathered, you will secure your 
gathering with the same backstitch procedure. Closely trim 
the excess thread tails.

• �Use running stitches for gathering. 
To begin a running stitch, secure 
your thread into the ribbon with 
a few backstitches then proceed 
with fairly even running stitches. 
Take at least three or four stitches 
at one time before pulling the 
thread through the ribbon. You 
can stitch very close to the bot-
tom edge of the ribbon if it has a woven edge. Stitch 1/8” 
from the bottom edge of the ribbon if it is a raw edge.

• �Patience - don’t fret if your fingers don’t seem to do what 
they should. Ribbonwork isn’t done quickly and it can be 
“fiddly”. Many times, especially when you’re new to rib-
bonwork you’ll feel “all thumbs”. Be patient. Give yourself 
a chance to get used to the feeling of working with thin 
needles and weightless ribbons and soon this “all thumbs” 
feeling will disappear with experience and time.

Supplies For One Rose Brooch 
• 36” of 1½” wide ombre wire edge ribbon
• 12” of 1½” wide green ombre wire edge ribbon
• 3” x 2” piece of crinoline
• 3” x 2” piece of felt
• Milliners Needle #10
• Ribbonwork Thread
• 1½” long pinback

Make a simple ribbon rose brooch 
using French wired ribbons and 
easy hand-stitching, and then pin 
it on your favorite jacket, hat or 
purse. Tres chic!

f r e n c h  r i b b o n
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5. �With a second needle and 
thread, sew the rose center 
(cylinder shape) to the middle of 
the 3” piece of crinoline 

6. ��Coil the gathered ribbon around 
the center cylinder. until a rose 
shape is created in a manner pleasing to you. If the rose shape is 
too flared out, then loosen the gathering by pulling the gathered 
ribbon away from the center. If the rose shape is too tight and not 
flared out enough then increase the gathering by pushing the gath-
ered ribbon closer to the center. This seems odd but it works. Once 
the rose shape is as you like it secure the rose through all the layers 
at the base of the ribbon to the crinoline so they don’t pop out. The 
raw edge end of the ribbon is gathered and hidden under the ruffled 
ribbon. The ribbon rose should stand upright. Set it aside until the 
leaves have been added and then some styling and shaping will be 
done to the rose.

Shaping the Leaves
The three leaves use 4” of 1½” wide green wire edge ribbon each and 
the prairie point leaf technique. 
1. �Decide which color edge of the ribbon 

you want to feature on your leaf then 
remove the wire on the opposite edge. 
When making more than one leaf con-
sider changing the color edge for variety 
in the corsage. 

2. �Mark the halfway point of the ribbon 
length and fold down one end of the 
ribbon at that point. 

3. �Fold the other half of the ribbon down. 
A triangle shape has now been formed. 

4. �Turn over this shape and notice the 
bottom edge of the ribbon -  

the non-wired edge - and use this 
line as a guideline to sew the 

gathering stitches across 
the bottom going 

through all layers of 
ribbon.  

5. �Gather the stitching 
very tightly, wrap the 
thread around the 
base of the leaf once, 
pull tightly and secure 
the wrap with a few 
stitches. Cut the thread 
and trim the excess 
ribbon from the base 
of the leaf. The leaf can 
be used on either side.

Assembling the Brooch
1. �Sew the leaves to the crinoline so the ribbon layers of the rose 

hide the raw edges of the leaves. Overlap and sew two leaves 
to one side of the coil rose and sew one on the other side of 
the rose. A few extra stitches in the hidden folds of the ribbon 
will anchor the leaves and the rose to the crinoline.

2. �Style the rose by 
slightly flattening 
it with your hand 
or simply “fluff” 
the edges of the 
ribbon until you 
like the shape. 

3. T�rim the excess 
crinoline from 
the rose and 
leaves and 
cover the back with felt. Sew a pinback to the felt. Pin to a 
hat, jacket or purse.

For more ribbon embellishments and 
classical techniques for manipulating and 

stitching ribbon from Helen Gibb, 
see her books, Elegant Ribbonwork 

and Ribbonwork, The Complete Guide.

Visit Helen online at 
www.helengibb.com
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through the needle

By Debbi Lashbrook

 Part 2

One of the best features of some embroidery 
software programs is the ability to create 
your own designs. Turning artwork into stitches –
digitizing – is a creative process that can be satisfying 
and rewarding. Second in a 3-part series, this article discusses stitching order, color, digitizing tools, and refining designs. 
A good design starts long before the stitching process because good embroidery can never make up for bad digitizing.

Stitching Order
When determining the stitching order of the design, there 
are a number of considerations that influence the orga-
nization of the design. Keep these in mind as the design 
evolves.

What influences stitching order? 
• �Visual order: Background elements will be stitched first, 

then intermediate areas, next, foreground, and last, 
the details. Items in the foreground overlap items in the 
background and not vice versa. 

• Number of colors planned
• �Size of areas: Large areas should be filled before smaller 

areas because more distortion will be created with large 
areas

• �Direction of stitching: Stitching from the center of the 
design out will help eliminate gaps and puckering of later 
objects

• �Real life order is important—for example, clothing goes 
on top of the body

What are the consequences of 
stitching order?
• �Jump stitches must be out of the way of other stitch-

ing or be trimmed first (especially important when jump 
stitches occur with the same color)

• �Each jump stitch and trim costs about 100 stitches 
worth of sewing time

• �Some items—such as eyebrows—have to have jump 
stitches and can’t be hidden. Other items, such as 
wrinkles and accent lines can be pulled into the outline 
edge without changing the characteristic of the design) 

Is it best to stitch details on top of 
fills or in holes?
• �Tiny details are best set on top of another fill, with an 

angle 90° different than the fill
• �If there are light details on 

dark fills, holes are best to 
avoid “shadows”.

• �Large details can be worked 
from a hole in the base fill, 
saving thread and time

Design from My Designs>
Animals>FL852. Leaves 
must stitch before the 
flower, which must 
stitch before the 
butterfly.

Design from 
My Designs> 
Animals> Frog. 
Eyes have jump 
stitch; accent 
lines of feet are 
part of the 
outline stitch.
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Color
Determine the number of colors 
and the sequence of the colors.

• �Decide on colors to be used after the visual order is  
determined—if two colors are in the background, digi-
tize the lightest color first so that traveling stitches are 
between light colors (dark traveling stitches might show 
through the lighter colored fills).

• �Economy of color changes—all parts of the same color 
are stitched together if possible to save time in chang-
ing thread colors but you must consider the effect on 
the depth of the design. If the appropriate visual order is 
sacrificed by stitching the same color in two areas with 
travel stitches between, it is better to have jump stitches 
and change thread colors more often to preserve the 
depth of the design.

Ways to decrease the number of 
thread changes: 
• �Consider colors that can be eliminated or combined to 

eliminate thread changes 
• �Remember that because of light reflection, changing the 

angle will produce the look of another color without a 
thread change

• �If working with a color picture as a backdrop, consider 
the importance of each color and make substitutions 
for those with lower priority–perhaps blending colors will 
give the effect you want

• �When digitizing flowers, digitize the stems last—they can 
be used to cover traveling stitches between leaves 

• �If there are decorations in an object or a lot of spots 
such as in the frog design, consider if they can be digi-
tized first to eliminate jumps—it is not always possible, 
but may save time.

Stitch Types 
Refer to Digitizing 101 – Part 1 in Through The Needle Is-
sue #22 for a complete list of stitch types.
• �Use the reference files found in My Designs> Reference 

or look in the Appendix of the On-Screen Manual for 
samples of fill stitches as a guide for selecting stitches.

• �The stitch type is most often determined by the size of 
the filled area and the look you want to achieve.

• �A variety of stitch types adds personality and makes for 
a more interesting design.

• �Satin fills are best for small areas and details—no wider 
than 10mm. They tend to stand up from the fabric and 
are better for objects in the foreground.

• �Step fills are mostly flat and hug the background fabric; 
some have fur-like quality. 

• �Fancy fills add texture and interest to a design and 
should have a density that complements it without over-
whelming it.

• Craft fills are great for decorative or special affects
• �The decision to outline or not is your choice: outlining 

helps define edges, but is not always necessary. Heavy 
outlines can result in a “coloring book” effect.

Jump Stitches
Jump stitches are long stitches that result when the needle 
moves from one section to another of the same color. 
These stitches should be removed before they are stitched 
over so keeping the number of jump stitches to a minimum 
is desired.
• �To minimize the number of jump stitches, it is best to 

manually digitize the artwork, rather than use auto  
digitizing.

• �Use traveling stitches (also called walk stitches) instead 
of jump stitches between the digitized objects of the 
same color; these stitches should be single outline 
stitches using the default length. An object that is digi-
tized later will cover them such as in the crossed candy 
canes design.

• �Set the stitches so the last stitch of one area is close to 
the first stitch of the next area—this is done by changing 
start/stop points or digitizing walk stitches around the 
edges of an embroidery design. 

In this design, yellow must 
stitch at different 
times because 
the yellow in 
the ribbon 
must stitch 
prior to the 
purple, but 
the yellow 
on the basket has to stitch after the 
orange basket and the orange flowers.

The red cross 
indicates the 
last stitch of the 
object, the green 
square indicates the 
first stitch of the object. To 
make these visible, select the 
object, then select the Reshape Object tool. 
Move start/stop points by clicking and 
dragging the cross or square where desired.
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• �If you cannot avoid jump stitches, try and make them as 
long as possible, so they are easy to clip. Changing the 
start and stop points of objects alters the length of the 
jump stitch. 

• �If jump stitches must be short (between lettering, for 
example) use a small piece of water soluble stabilizer to 
make them easier to trim. Place water soluble stabilizer, 
such as Aqua Film, over the area to be stitched. Note: 
This does not take the place of stabilizer behind the 
design.

• �Sometimes jumps between elements can be pulled to 
an outline edge without changing the character of the 
design (creases, folds, etc.) as in the frog design.  

• �To convert jump stitches to traveling stitches: Travel to 
the jump stitch, insert a single outline traveling stitch. 
Note: Traveling to insert stitches will be covered in Part 3.

• �To convert traveling stitches to jump stitches: Select the 
travel stitch, press the delete key.

• �To tell the difference between jump stitches vs. walk 
stitches, look at artistic view—jump stitches do not show 
in artistic view.

Underlay Stitching  
Underlay has several purposes: To secure backing to 
fabric, to help eliminate stretching on difficult fabrics, to 
achieve accurate stitch registration, to make designs stand 
out on garments, to add dimension, and/or to flatten 
napped fabric.

Underlay Facts:
• �Most filled areas need some type of underlay—if the fill is 

larger than one grid square, it should have underlay.
• Underlay stitching should be 90° to the fill
• �Good underlay stitching can let you reduce the density 

to avoid “bullet-proof” embroidery.
• �The type of underlay stitching used depends upon the 

type of stitch.
      - �Satin stitches—use vertical row of straight stitches 

(for narrow) or a double zigzag (for wider)
      - Step and fancy fills—use step underlay
      - �Lower density areas—use edge walk (helps keep the 

edge of the fill smooth and even)
      - �Cutwork—use two rows of narrow straight stitches 

and an open zigzag for padding

Software Tips: 
• �In V5 of the BERNINA® Embroidery software, a step 

underlay is automatically added to manually digitized ob-
jects. You may choose to change the type of underlay or 
you may want to add a second type of underlay. To add 
a second type of underlay, select the object, right click 
to open Object Properties, then select Effects >Underlay. 
Place a check mark in front of the Underlay 2 and click on 
the drop down box to select the second type of underlay. 

• �To digitize your own, turn off automatic underlay by click-

ing on the icon. Make a copy of the object. Next, select 
the original object and right click on Object Properties, 
then change the stitch spacing. If you set the stitch 
spacing to 2.5mm, the underlay spacing will be close to 
the spacing of automatic underlay. Change the angle of 
the object with decreased density so that it is perpen-
dicular to the angle of the object. 

• �Sometimes you can digitize one light-colored underlay or 
monofilament thread underlay for the entire design so it 
will stitch all at the same time rather than separately for 
each part; this has to be digitized with the closed object 
tool, decreasing the density through Object Properties as 
described above.

Stitch Angles
Add texture and 
interest to your de-
signs by manipulat-
ing the angle of the 
stitches.
• �Setting fill angles 

differently in each 
adjoining section 
will help add tex-
ture and interest 
to the design by 
reflecting the light differently; this can also decrease the 
number of color changes.

• �Fills sewn in horizontal lines have a flat look; good for 
backgrounds.

• �Fills sewn in vertical lines have sheen and appear to 
stand out from the surface; good for foregrounds.

• �A good approach is to choose an angle that is close to 
parallel to one or two sides of the object

• Use a protractor to determine the value of the angle 

Stitch Length
Customize the look of your design by varying the lengths 
of the stitches you digitize.
• �Long stitches give a loftier, shinier look; shorter stitches 

break up light.
• �If the stitches are too long, they can snag or loop; if too 

short, the thread can break.
• �Decrease the stitch density when you increase the stitch 

length because longer stitches cover better.
• �Short stitches lie flatter, but you should not use stitches 

for a fill that are less than 2mm (4mm is the default for 
most fills).

• �Satin stitch lengths should not be shorter than 2mm; 6-
7mm is the maximum length that can be used without a 
lot of underlay support.

• �Outline stitches should be between 2-4mm; severe 
curves may require that the length be reduced to 1-
2mm, but only in the curved areas.
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Refining Designs
Before the first stitching, refine your design to insure the 
best possible finished results. An important consideration 
is compensating for the push/pull of the stitching process. 
Without compensation, the fabric can pucker (even if  
properly stabilized) and cause gaps in the design.
• �Stitches will pull in the direction of the stitch angle and 

push in the perpendicular direction. 
• �The amount of effect varies over the design, depend-

ing on where the design is, which way it is angled, and 
whether it is outlined or not. 

• �Pull causes designs to shrink by as much as ½ mm on 
each side.

• �Compensation settings make the total section larger by 
the amount selected, but sometimes more is needed. Pull 
Compensation is set automatically to 0.2 mm. To change 
the pull compensation of the total design, select all of the 
design, right click to open Object Properties, then select 
Effects > Others. Click on the drop down arrow next to Pull 
Compensation and choose one of the specified amounts 
or type in a specific amount in the box.

• �Pull Compensation settings may also be changed by 
choosing the fabric type. Go to Settings > Fabric Settings 
and click on the drop down arrow and select the type of 
fabric you are embroidering. The software will choose an 
appropriate pull compensation for the type of fabric. 

• �Fabrics that may need more compensation: Knit fabrics 
(stretch causes shape change), Terry fabrics (prevents 
loops from showing through the stitches), Plush pile (so 
stitches aren’t absorbed by pile).

Other ways to compensate for push/pull
• Underlay stitches can be used to reduce push/pull.
• �Use overlapping objects when digitizing to help eliminate 

gaps. Instead of objects just touching at the edges, the 
objects are digitized with a 1-3 mm overlap. The amount 
depends on:

	 - Density of stitching
	 - �Size of the stitched area—a large filled area 

needs more compensation than a small area 
	 - �The “give” of the base fabric (more overlap is 

needed for knit fabrics)
• �Adjust shape of objects digitized: Egg shape is digitized, 

but will be a circle after stitching 
• �Digitize outlines for push/pull 

by placing digitized points 
so that they are set in slightly 
across the perpendicular fill 
and are close to the edge of 
the parallel lines of the fill.

• �In satin columns, as they 
become more narrow, push/
pull compensation needs to increase to make the let-
ters more bold; if lettering is too thick, decrease the pull 
compensation.

• �If a shape is pulling away from an outline, increase the 
pull compensation; if a shape pushes out beyond an 
outline, decrease the pull compensation.

Coming in Digitizing 101 – Part Three: Stitch-
ing a Test, Analyzing, and Editing a Design

Digitizing Tools and Tips
 TOOLS

         Open Object – draw and digitize open shapes and lines; only used with outlines

         Closed Object – draw and digitize closed shapes; can be filled objects or outlined objects

         Block Digitizing – Digitize columns (cannot be used for outlines); use for digitizing multiple angles within a filled object 

         Oval – Draw and digitize ovals and circles 

         Rectangle – Draw and digitize rectangles and squares

         Reshape Object – you can always edit your digitized design with the Reshape Object tool

 TIPS
• Right clicks give a curve shape; left click to left click results in a straight line. Left clicks are also used to change direction 
• Remember, you must select an object before any changes will be made to the object.
• If you are having difficulty selecting a specific object with the selection arrow, hold the number 2 key down while selecting.
• �Digitize first in the default colors to help you keep track of the stitching order; use a different color for every object digitized, which 

makes it easier for editing via the Color Film function. 
• Remember, you load a picture; you do not open a picture.
• �Always digitize the design 3x its size or more; the artwork should be the actual finished size, but use the zoom tools to increase the 

size of the picture behind your digitizing. Being able to see what must be revised is part of the creative process.
• Be prepared to sew, then edit—especially if the design is heavily detailed; the actual sew-out is where true results are seen.
• �Save your design often, after every major component is completed, with different file names. By saving in this manner, you won’t 

have to start completely over if you need to go back.



My friend, Jarita Pascasio, introduced me to this unique  
garment that she was making for her high school daughter. 
The skirt was such a hit that she is now making them for a 
trendy little boutique in an upscale shopping area across from 
the University. They sell for $100+ and have become collect-
ables. This is the type of project that makes sewing cool!

Instructions
• �Select a theme such as travels, hobbies, or favorite activities.

• �Collect a variety of T-shirts relating to your chosen theme; colors can be mixed or all shirts 
can be the same color.

• �Dissect the shirts, cutting squares and rectangles as desired, being careful to keep any  
messages on the front and back intact.  

• �Arrange the pieces as desired to create fabric large enough to accommodate your favorite 
simple skirt pattern with elastic waistband.

• �Serge pieces together  
using a 3- or 4- thread 
balanced stitch. Stitch 
with seams on the     
outside to add interest.

• Use your favorite elastic 
technique for the waist.

• �Finish the lower edge with the serger or turn the hem up and cover 
stitch in place. Note: Another option is stitching the hem with the   
sewing machine using a double needle and straight stitch.

This isn’t brain surgery, but it does take a 
certain eye to create pleasing balance…

Trust your judgment…Don’t over think the 
choices…Enjoy the creative energy that this 

project inspires!

THROUGH THE NEEDLE
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By Vicki Tracy

Why make a skirt out of your 
T-shirt collection?
• �It’s a unique memory garment with the same bragging 

rights as the t-shirt quilt but have you ever seen anyone 
who looks good wearing a quilt? 

• It’s comfortable and fun to wear.

• �You won’t believe what a great conversation starter it is!

• �The Sassy Skirt is cozy enough to curl up with a good 
book or you can dress it up with jewelry and great shoes 
to wear anywhere!



Serging Setting Notes
Use the excess parts of the 

t-shirts to test the differen-

tial setting of the serger. If 

the knit is stretched while 

being stitched, adjust the 

differential feed to a higher 

number to achieve an un-

stretched, flat seam.

If using a serger equipped 

with mtc (Micro Thread 

Control), you can easily 

make the stitch look great 

with a minimum of tension 

adjustments. With mtc, over-

hanging thread loops at the 

cut fabric edge are eliminat-

ed, resulting in professional 

seaming and edging with a 

minimal amount of effort.
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activa Art
Visit the BERNINA® USA website to 
see the companion projects to activa 
Art 210 on page 4 of this issue of Through The 
Needle. Each of the activa machines has it’s own 
expression of creative art. Make the art pieces 
designed for activa models 220, 230 PE, and 240. 
But don’t let the names fool you, any model of 
BERNINA® machine can be used to create these fun works of art!

Online Classes
Want to learn more about software and sewing? 
Join one or both of our societies – the Quarterly 
Software Society and the Quarterly Accessory 
Society. Visit with other stitchers who love to sew 
what you love to sew. Work through the quarterly 
lessons, ask questions, and share your experi-
ences. New classes are posted the last week of 
each quarter.

Online Classes > Quarterly Software Society and 
Quarterly Accessory Society

If that’s not enough, check out the About Ambience series of classes. This series works 
through the creation of a quilt based on the book Aquamarine Ambience by Simon
and Jenny Haskins. New lessons are posted every two months with a total of six lessons 
to be available.

Online Classes > About Ambience

Happy Anniversary
If you haven’t heard, BERNINA® is celebrating the 75th  
anniversary of the BERNINA® brand. Check out the 75th  
anniversary website – Our anniversary. Your year.

www.berninausa.com/75
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Supplies
• �½ yard each of 8 

Assorted Bali Fabrics
• �½ yard of fussy cut fabric for appliqué 

(Caryl Bryer Fallert’s “Gradations” by Benartex 
used for the sample)

• �½ yard fabric for binding
• 3 yards backing fabric
• 54” square of batting
• Patchwork Foot with Guide #57
• Embroidery Foot #26
• BSR - BERNINA® Stitch Regulator #42
• Walking Foot #50
• #0 Brass Safety Pins for basting 
• #70 Denim Needle for Piecing
• #80 Organ Needle for Embroidery
• OESD Aqua Mesh Stabilizer
• HR5 Temporary Spray Adhesive
• Assorted colors of Isacord Embroidery Thread
• Large Oval Embroidery Hoop
• Rotary Cutting Equipment
• BERNINA® Embroidery Software

By Nina McVeigh

This beautiful quilt uses a 

traditional block, Drunkards 

Path in a contemporary way. 

The modern Bali Batiks, the 

random setting, appliquéd 

rectangles, and quilting in 

the machine embroidery 

hoop all work together 

to make this stunning study of 

warm colors playful and soothing at the  

same time.

The following tools and icons are used in 
designing and creating this quilt.

Quilt Layout 

Quilt Library

Auto Appliqué

Partial Appliqué

Open Object

Closed Object

Rectangle 

Circle/Oval

Embroidery Window
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Designing the Quilt
Begin by opening BERNINA® 
Embroidery Software and 
then the Quilter Program. 
Once the Quilter Program is 

open, select the Quilt 
Layout icon.

 
Place 6 blocks across and 6 
blocks down; make the blocks 

8”. There is no sashing and 
there are no borders.

Select Library > Blocks > Drunkard’s Path 
> Drunkard’s Path 2. The block will open in 

the window at the top of the page. Click each 
square to add the blocks to the layout. Hint: If 

you hold down CTRL and ALT keys, all the blocks 
will be changed to Drunkard’s Path. Remove a 

few of the Drunkard Path blocks so that some of 
the blocks are plain squares. Randomly change the 

direction of the blocks.

Select the Fabrics tab. Choose Benartex 2006 > Baliís 
Tutti-Frutti. Randomly fill blocks with the pink, purple and 

orange fabric prints. Save the quilt design and close the 
Quilter Program.

Designing the Appliqué
With the BERNINA® Embroidery Software, you can design 

the appliqué shapes by using the Auto Appliqué and the 
Partial Appliqué features. Select the Auto Appliqué Tool and 

draw a rectangle. Follow the prompts in the Status Bar to create 
an appliqué. The software will automatically create a placement 

line, a tack down stitch and a cover stitch. Continue until you 
have 3 intersecting rectangles. Select All and right click for Object 
Properties. Change the cover stitch width to 2.5 and the tack down 
width to 2.0. With 
everything still selected, 
use Partial Appliqué 
Tool to remove stitching 
from overlapping areas.

To add a decorative 
stitch around each 
appliqué, select the 
Open Object Tool. 
Draw a line around the 
satin stitch portion of 
the bottom rectangle 

that shows. Select Outline Stitch > Pattern Run > Object
Properties > Pattern Set > Heirloom > #a703. Change the 
color of the stitch to yellow. Repeat for the middle rectangle 
using Embellishment stitch #601 and color royal blue. The 
top rectangle may be drawn using the Closed Object Tool. 
Use Cross Stitch #313 and change the color to aqua blue.

Ideally these decorative stitches should be sewn between 
the tack down stitch and the cover stitch of each shape. To 
do this, select a rectangle making sure that it is ungrouped. 
Go to Arrange > Break Apart. You will now be able to place 
the decorative stitch for that rectangle between the tack 
down stitch and the cover stitch by clicking and dragging it 
in the Color Film bar.

To add colored fabrics to each rectangle choose Rectangle > Object 
Properties > Fabric > Choose. To put decorative stitches on the 
appliqué, select a rectangle. Using the Open Object tool draw a 
line about ¼” long. While the line is selected, change from a single 
outline to satin. Scatter this stitch throughout the rectangle. This is 
easily done by cloning the stitch - right click on the shape and drag 
it to where you want another stitch. Repeat for the second rectangle 
making the line a small zigzag. For the third rectangle, use the circle 
tool and make a tiny circle using a satin stitch fill. Save your design.

Go back to the Quilter Program and open your quilt design. Add the 
appliqué to the quilt by clicking on the Embroidery Window Icon; the 
embroidery window will open. Go to File > Insert Design. Choose 
the appliqué design you just created for your quilt. Click on the quilt 
layout (still visible on screen), the appliqué design appears in the 
very small window. Click and drag to where you want it to appear. 
Copy and Paste additional appliqué designs randomly throughout 
the quilt. I used the design 9 times. You may add quilting with the 
motif of your choice. Save changes to your design.

Select Print Preview > Block Construction and print the Drunkard’s 
Path Block pattern. Using the eight assorted Bali fabrics, cut out 
blocks and squares for quilt.
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Piecing the Quilt Top
Piece the Drunkard’s Path blocks using a #70 denim needle and the 
Patchwork Foot with Guide #57. 

Refer to the quilt layout (you may also want to print this for a 
reference) and join 6 blocks to make a row. Make 6 rows and stitch 
the rows together to make a 6 x 6 block top.

Machine Embroidered Appliqué
Attach the embroidery module to the machine. Insert a #80 Organ 
needle. Transfer the appliqué design you created in the BERNINA® 
Embroidery Software to the machine. 

Hoop the Aqua Mesh stabilizer in the large oval hoop; spray the 
stabilizer with the HR5 Temporary Spray Adhesive. Lay the area 
of the quilt you would like to appliqué on top of the stabilizer and 
smooth in place. Attach the hoop to the machine.

The appliqué design may be mirror imaged or rotated for desired 
effect. The machine will stitch a placement line for the appliqué 
piece. Lay a piece of fabric over the stitched area. Note: I like to 
repeat the placement stitching at this time. If you choose to do that 
you will trim away the excess fabric after stitching the placement line 
a second time. 

The next step will be the tack down stitch. You may trim after the 
tack down stitch if you did not do so before. 

The decorative stitch will sew next and the last stitch of the appliqué 
will be the satin stitch.

Repeat these steps for the other two elements in the design. 

Quilting Designs
When the appliqué is finished, layer the 
backing, batting and top. Pin-baste the layers 
together with the small brass safety pins. 

With the embroidery module still attached 
to the machine select the quilting motif you 
would like to use on the quilt. Hoop the three 
layers together in the large oval hoop. You will 
not need a stabilizer for most quilting motifs. 
Thread the bobbin and needle with the same 
thread. Stitch the motif, trim threads and move hoop to the next area. 

Finishing
When all motifs have been quilted, free-motion quilt the area 
between them using the BERNINA® Stitch Regulator. 

Trim the edges of the quilt even and attach binding using your 
favorite binding method. Note: For additional information on binding, 
go to www.berninausa.com > Online Classes > Sewing Classes > 
Binding Basics.

Tips for piecing 
curved seams:

• �Place a pin at 
the center of 
the two curved 
edges to create 
a registration 
mark for 
matching.

• �Sew with the 
outer curve on 
top of the inner 
curve, using a 
stiletto to help 
guide the fabric.

• �Sew at a slow 
even speed, 
matching pins 
as you sew 
(remove pins 
as you reach 
them).

• �Press the 
seams toward 
the outer curve.
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Compared to What?
I’ve always compared: Who has more than me, who has less? Who’s better, who’s worse? I even compare my quilting, so that when I look 
at the spectacular works of other quilters I sometimes want to cry. You know the feeling: “I’ll never be as good, as creative, as technically 
perfect.” (Or, on the other hand, “I’ll never have 100 hours, much less the desire, to spend sewing thousands of beads and sequins to a 
quilt!”)  Instead of inspiring me, I allow others’ quilts make me feel like a “less-than”. 

For the longest time, I refused to show my quilts to others, sure that they would ridicule them for poor craftsmanship or lack of imagination. 
I was always afraid of being found out for not measuring up to snuff. But somewhere in the last few years, I’ve turned a corner. I’ve real-
ized that I’ve been giving other people—whether they wanted it or not—too much power over me by putting my self-esteem in their hands. 
Finally, I’ve come close to embracing the idea that it doesn’t matter what other people think, it only matters what I think of my work, and 
if my work pleases me. I quilt because it brings me joy, because I love the way the fabrics look when placed in juxtaposition, the interplay 
of the colors, threads and fibers, and creating something out of raw materials. I love having a creative hobby that let’s me express what’s 
inside. What’s more, I’ve realized that most people could care less if my quilts are good or bad. They are far more interested in their own art 
and growing it than making judgments about what I do. And even if they are making judgments, what other people think of me is none of 
my business, as Mary Tyler Moore was once quoted as saying.

The Pitfalls of Comparing
It can be incredibly damaging to compare your quilts to that of others; it not only puts a damper on your creativity, but also your enjoyment 
of the creative process. One of the dangers of comparing is that it doesn’t allow you to be a beginner. We often expect to master a creative 
skill right from the start. We don’t give ourselves time and permission to be a novice, but instead, immediately label ourselves as untalented 
if we produce a rudimentary quilt. But what is talent? Really nothing more than a natural affinity for a creative endeavor. If you don’t cultivate 
it, talent won’t get you very far. That means you have to practice and experiment. You have to work at your quilting, make mistakes, learn 
from those mistakes, and grow with your work. As Aristotle said, “We are what we repeatedly do. Excellence, then, is not an act, but a 
habit.”

Another danger may be the way you originally learned to quilt—or even before that, the way you were taught to make art, both of which af-
fect your perspective on your quilting in comparison to others’ work. You were probably told to follow the directions and do what everybody 
else did. And if you colored outside the lines or drew an abstract image when a realistic visage was called for, you might have been chas-
tised. So unconsciously today you may believe that there is only one right way to quilt—and perhaps you think you’re doing it the wrong 
way. Not because you don’t want to do it the right way, but because you’re technically not capable of doing it that way. Or you may feel that 
you’re not capable of going to the outer reaches the way some special, really original quilters do, to make something that is truly unique. (I 
sometimes think that my ability to conform, which helped me to do well in school and in the business world, led me to repress my creative 
side.) But you have to let go of all that, and give into your natural inclinations and quilt your way. 

It’s also critical to learn to let your quilts stand on their own compared with the image of the “ideal” work you see in your head. Sometimes, 
you just can’t achieve that ideal, and sometimes, you’ll achieve something better if you stop letting your inner critic get the better of you. 
Instead, let fly your intentions, instincts and intuitions when you quilt, discovering as you go and letting the work guide you instead of fixating 
on your “head” image. Try working in a series, so you can see how your quilts are progressing. And give yourself permission to do whatever 
you want, instead of following the rules. One of the greatest things about quilting today is that the rules are broadening so that anything now 
goes. Good, careful work is still important, but if you’re not good at one technique—like setting in seams—you can opt to do something 
else. You don’t have to work against your natural personality if you’re not a detail person. 

Quilt for yourself and yourself alone, so you preserve the fun and satisfaction and reduce the anxiety of performing for others. Better than 
comparing, try persevering!

By Nancy Monson



Machine Setup
• �Bernina® Sewing machine set on 

straight stitch
• Feed dogs dropped
• �Needle Punch Accessory attached  

as per directions included with  
accessory

• �View the DVD packed with the 
Needle Punch Accessory for easy 
installation of the accessory, and to 
gain ideas for use.	

Punched Design 
• �Use chalk to draw a simple branch 

on wool for beginning stem and floral 
placement.  This is just a guideline 
– the design will take on a life of its 
own as you progress. 
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Needle Punch Tips
• �The design shown was 

punched by placing a picture 
of a crewel embroidery 
design within sight, using 
it as a basis for structure. 
You may use a photo of a 
flower, a drawing, a greeting 
card–or simply let the design 
evolve. Working with the 
fibers is much like working 
with chalks or pastels – you 
add shading and colors as 
you go.

• �Keep a scrap of fabric close 
by to test fibers on before 
trying them on your project.

• �Set the machine to a slower 
speed, reducing the chance 
of needle breakage.

By Edna Gregory

Finished size: approximately 20” x 24”

This simple wall 
hanging features a 
needle punched 
floral design using 
a variety of 
decorative fibers 
and is framed by 
curved borders. 
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Supplies
• �BERNINA® Needle Punch 

Accessory Set

• �BERNINA® Sewing Machine 
(5.5mm) with appropriate 
stitch plate

• �Center background fabric: 
Approximately 14” x 16”– 
felted or boiled wool, light-
weight denim, flannel or 
chamois, raw silk or other 
natural fiber. Note: Do not 
use fabric that contains 
Lycra.

• �Assorted fibers for needle 
punching such as wool rov-
ing, acrylic yarn, silk roving, 
Angelina, and Angora.

• �¾ yard border fabric– 
Benartex Glacier Park flannel 
by Caryl Bryer Fallert was 
used for the sample

• �Lightweight batting, such  
as Thermore or wool batting 
24” x 28”

• �One yard fabric for backing 
and binding

• Thread for machine quilting 

• �Beads for accent – 10/0  
seed beads were used in  
the sample shown

• Wooden skewer

• Flexible design curve

• �Patchwork Foot #37  
or Patchwork Foot with 
Guide #57

• �BERNINA® Stitch Regulator 
(BSR) #42 or your favorite 
free-motion presser foot

• �Lay a piece of yarn, roving or other fiber in 
place along lower stem line, and “punch-
baste” lightly in place. Use a wooden 
skewer as an aid in positioning it. After you 
are certain of its placement, punch it firmly 
into place.

• �Work on the design, placing the most dis-
tant items first, moving towards the front of 
the design, the same as you would work an 
appliqué design. Use lighter colors around 
the outside, and place darkest colors to-
wards the center of the design. 

• �Needle punch light layers of fibers in place, and then add accent colors and/or shading. Do 
not begin with heavy clumps, but gradually add fiber shading. 

• �Use small amounts of light yellow, ivory, or white 
for accents and sparkle. Novelty fringe yarns add 
dimension.

• �Once you are satis-
fied with your design 
you may punch it 
from the back as 
shown on the DVD, 
and again from the 
front. Note: Punch-
ing the design from 
the back is optional. 
You can work the 
fibers in as firmly or 
as gently as you like 
– this is your project, and your end use will deter-
mine how firmly the fibers should be attached to the background.

Adding the Border
• �After the center design is complete, use chalk and a flexible 

curve to create a pleasant outer edge line on each of the sides.
• �Cut the outer borders 6” to 7” wide, 24” long for the sides, and 

20” for the top and bottom.
• �Lay the borders out, folding mitered corners into place if desired.
• �Lay the center design over the borders, adjusting chalk lines to 

meet border miters.
• �Cut center and borders along the chalk lines at the same time, 

working with only one side at a time. (Fold the other sides out of 
the way).

• �Using Foot #37 or #57, add borders with ¼” seam; press seam 
allowances toward border. Needle punch or stitch trims along 
seam line if desired, working on the center fabric and avoiding seam allowances.

• �Layer with batting and backing, and baste or pin the layers  
together. Extra batting may be placed under the center floral design for added dimension. 
Using the BERNINA® Stitch Regulator (BSR) or your favorite free-motion presser foot, outline-
quilt around the needle punched design. Small stippling in the background raises the center 
design for more dimension. Note: For more specific information on free-motion quilting, see 
the BERNINA® publication, Feet-ures, available from your BERNINA® dealer.

• �Quilt border as desired. Block quilt, and trim edges. Cut “photo-corner’ shapes from border 
fabrics; baste and press scant ¼’ under on curved edge; appliqué in place on each corner, 
using blind stitch.

• Remove the presser foot and attach beads as shown in the photo or as desired.
• �Add hanging sleeve if desired, and bind the edges using your favorite binding method. Add 

your own designer label to the back of the wall hanging.
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Cutting
Spray starch cotton fabrics to stabilize before cutting.
Fabric 1: �Cut fabric strips from selvage to selvage, wide enough 

to fit embroidery hoop
Fabric 2: �Cut four 7” squares. 

Cut four 7½” squares; cut each once diagonally for 8 
inset triangles.Cut two 5½” squares; cut each once 
diagonally for 4 corner triangles.	  
Cut four 4¼” strips selvage to selvage for outer 
border.

Fabric 3: �Cut four 1½” strips selvage to selvage 
for inner border.Cut about 220” of 
2¼” wide bias strips for double-fold 
binding (piece to make 1 long strip).

Machine Embroidery
Use the motifs as indicated on the layout 

diagram or choose your favorites. Working 
from left to right, stitch 13 embroidery motifs 

on the Fabric 1 strips. Allow enough space 
between the motifs to cut out thirteen on-
point 7” squares; use temporary adhesive 
spray to adhere the stabilizer to the back 
of the fabric before hooping. Using the 
large oval hoop, embroider one motif 
per hooping. Stagger the designs on 

the fabric strip, embroidering first in 
the upper half and then in the lower 
half of the hoop. Remove the hoop 
and trim excess stabilizer from 
the back of the designs. When 
all the embroidery motifs have 
been stitched, cut out the 
7” embroidered on-point 
squares. Tip: The Nifty  
Notions 7” square is an ideal  

tool for this.

Baltimore Today
This beautiful quilt of Baltimore Album designs features machine embroidery designs from 
Studio Bernina® Vol.3 Baltimore Elegance Design Collection by Elly Sienkiewicz. The unique 
                       border treatment features on-point blocks that gives an  

irregular shape to the overall quilt.

by Jane Michals

Finished Size: Approximately 45” x 45”
Finished block size is 6½”; seam allowances are ¼”. 
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Baltimore Today
Supplies
• �Fabric 1 –  

Embroidery  
Background: 2 yards 
(includes extra for 
test stitching)

• �Fabric 2 –  
Contrasting Blocks 
& Outer Border: 11/3 
yard

• �Fabric 3 – Inner  
Border and Bias 
Binding: ¾ yard

• �Wool Appliqué  
Fabric: ¼ yard

• �Hobbs Heirloom 
60/40 Quilt Batting, 
48” square

• �Backing Fabric:  
2¾ yards	

• �7” Nifty Notions “Cut 
for the Cure” square

• �Quilter’s Ruler with 
45° angle marking 

• ��Studio Bernina® 
Vol.3 Baltimore 
Elegance Design 
Collection by Elly 
Sienkiewicz

• �Isacord or Mettler 
Poly-Sheen  
Embroidery Threads 
for machine  
embroidery

• �OESD Heavy Weight 
Cut-Away Stabilizer 

• �Aurifil or Mettler  
Cotton Thread for 
quilt construction

• �Invisible Thread and 
Decorative thread of 
choice for quilting

• �Heavy Spray Starch

• �505 or HR5  
Temporary Adhesive 
Spray

• �Patchwork Foot #37 
or #57

• Walking Foot #50

• �BERNINA® Stitch 
Regulator #42 (BSR) 
or other free-motion 
presser foot

A number of the motifs contain appliqué; follow the directions that come with the embroidery collection when 
stitching these. For additional information, see the BERNINA® OnLine Class, “Embroidered Appliqué” by Jo 
Leichte.  (www.berninausa.com > online classes > embroidery classes)

 
Quilt Top Construction
Using the layout diagram, arrange the blocks and inset triangles of the quilt top on a design board. Some of the 
embroidery motifs are directional, so make sure that the tops of the designs all point to the top of the quilt. Using 
Patchwork Foot #37 or Patchwork Foot with Guide #57, sew the diagonal rows together. Press seams away 
from the embroidered blocks. Sew the rows together, pressing seams towards the bottom of the quilt.

Sew each 1½” inner border strip to one 4¼” outer border strip, making 4 border sets. Press each seam to-
wards the inner border. Fold each border strip in half, wrong sides together, making sure the bottom edges and 
seam are aligned. Align the 45˚ line on your quilter’s ruler along the bottom edge of the inner border with the 
edge of the ruler on the bottom folded corner of the border set. Cut the border set in half along the 45˚ angle. 
Repeat for each border set.

Arrange the 4 embroidered blocks and border sets around the quilt top on the design board, making sure the 
directional blocks are positioned correctly. Sew the 2 halves of each border set to the embroidered block. Press 
seams towards embroidered block.

Sew each border strip to the sides of the quilt, aligning the points of the center embroidered blocks on the quilt 
top with the points of the embroidered blocks in the center of the border sets. Stitch each seam, starting and 
ending ¼” from the edge of the quilt. Miter the corners of the borders. Stitch. 

Quilting
Piece the backing fabric as needed. Build the quilt sandwich. Pin or baste in place. Temporary adhesive spray 
is an easy way to hold the layers in place. Using the walking foot and invisible thread in the top of the machine 
and in the bobbin, stitch in the ditch of the seam lines to quilt. If desired, rethread the machine with a decorative 
thread and free-motion quilt in the contrasting blocks, triangles and borders using the Bernina® Stitch  
Regulator, or use 
a quilt design em-
broidery collection 
of your choice to 
quilt and embellish. 
Block the quilt and 
trim if needed.

Binding
Prepare the double-
fold bias binding. 
Aligning the raw 
edges of the bind-
ing and the raw 
edges of the quilt, 
sew the binding 
to the front side of 
quilt in one continu-
ous strip, mitering 
the corners. Turn 
binding to back of 
quilt and slipstitch 
firmly in place.

If desired, sew a 
hanging sleeve onto 
the back of the 
quilt.





                                                                            As a kindergarten teacher I have learned through the years 
                                                                 how to celebrate any occasion. I can put together a celebration for 
                             each letter of the alphabet, each season and each milestone in a child’s life. My summers are 
usually spent sewing, quilting and working part time for my local BERNINA® dealer - The Quilt Shop in Danbury 
CT. I’ve especially used my celebration skills at The Quilt Shop this year, commemorating the 75th anniversary 
of the BERNINA® brand. Since I bought my first BERNINA®, a 930, 27 years ago, I have had a warm spot in my 
heart for anything that has “BERNINA” on it. Over the past few years, I found myself searching on EBay for old 
BERNINA® machines. I started with an 1120, added a 707, then an 801 and on and on and on. Before I knew it 
I found myself with 9 BERNINA® machines.

I was asked to accompany the owner of The Quilt Shop, Ginny Murphy, to BERNINA® University in Orlando 
Florida. I knew that it would be a very special event because of the 75th anniversary. For weeks I tried to think  
of a way to bring my collection of BERNINA® machines with me. I knew that physically carrying the machines 
with me was impossible, but there had to be a way that I could show my BERNINA® heroes my collection and 
also say thank you to them for making such wonderful sewing machines. A quilt was too big, a photo album  
too plain, and the days were speeding by. Finally one day Ginny reminded me to pack a jacket in case the 
classrooms were cold. A jacket - that was the answer! We had 2 bolts of BERNINA® fabric at the store, red 
BERNINA® fabric and orange aurora fabric. I took pictures of my machines, printed them all on Printed  
Treasures fabric sheets and got to work. A week later the jacket was finished and packed  
in my suitcase. It contains machine embroidery sewn on my upgraded BERNINA® 200E,  
the paper pieced aurora sun from the purse pattern on the BERNINA® website, and free- 
motion machine quilting sewn with the aurora 440 and the BERNINA® Stitch Regulator  
(BSR) using King Tut thread from Superior. 

I was scared to wear my jacket for the first two days of BERNINA® University. Finally on the 
third day I pulled it out of the closet and put it on. I discovered I am not the only die-hard 
BERNINA® fan. People were stopping me everywhere telling me that they had the machine 
on my sleeve, or wanting to tell me about their collection. Of course this jacket is no longer 
truthful about my collection. I don’t have 9 BERNINA® machines anymore – I’ve already 
ordered the new aurora Limited Edition anniversary machine - and that takes me to number10!

By Roni Gerhardt
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By Jill Danklefsen

The tradition of the Entredeux stitch is an important part of the BERNINA® 
heritage as the founder of the company, Karl Friedrich Gegauf, invented the first 
Hemstitching machine in 1893. Combine simple piecing, appliqué and a wing 
needle with the Entredeux stitch to create a recipe that can be applied to 
                                                        many projects including home decorating 
                                                           projects, garments, craft items, and quilts.

Supplies 
• �Background fabric (at least 8” wide)  

as desired (natural linen was used  
for sample). Note: When working  
with a Wing needle, select a  
natural fiber fabric for best results.

• �Fabric strips – “In the Manor”  
collection by Kaye England for  
Benartex

• �OESD Light Weight Tear-Away  
stabilizer

• �Mettler Poly Sheen Multi –  
Color #9934

• �Mettler 50/3 Silk Finish cotton  
thread for piecing and blanket  
stitching

• Patchwork Foot #37
• Open Embroidery Foot #20/20C
• Clear Embroidery Foot #39/39C
• 80/12 Microtex needle
• 100/16 Wing needle

	 c. Place stabilizer underneath the stitching area to support the decorative stitch. 

	 d. Insert the 100/16 Wing needle; thread machine with Mettler Poly Sheen Multi.

	 e. Select the Entredeux stitch.

	 f. �Depending on the fabric, you may need stabilizer underneath the Entredeux stitch; stitch 

samples to determine if your fabric looks better sewn using stabilizer. 

Directions
1. Cut strips as shown in the diagram (cut width is indicated, length will be as desired). 

2. Sew strips together using an 80/12 Microtex, Patchwork Foot #37 and ¼” seams. 

3. �Place strip section on top of “background” fabric (linen used in the sample). Pin or secure in place 

using temporary spray adhesive.4. �Stitch in place along the seams and outer edges using a Blanket stitch and Open Embroidery Foot 

#20/20C. Move the needle position to far right and place the inside edge of the right toe of the foot 

along the seam. The blanket stitching will be in the perfect place!

5. �Frame the piecework with decorative stitches using the width of the presser foot for spacing. 

	 a. Attach Clear Embroidery Foot #39/39C. 	 b. Select a decorative stitch as shown or as desired. 

ELEGANT TRADITION

Stitch 

Machine/Model	  Blanket Stitch	  Decorative Stitch	  Entredeux stitch

ALL artista models	 #329	
#403	

#701

aurora 440QE	 #45	
#91	

#147

aurora 430	
#50	

#68	
#118

activa 240	
#41	

#50	
#76

activa 230PE	 #25	
#43	

#59

activa 220	
#28	

#30	
#41

Note: For a complete listing of stitch numbers for all current BERNINA® models, go to 

www.berninausa.com > sewing studio > basic training

For a project made 
with a variation of 
this Stitch Recipe, 
see the Serpentine 
Table Runner on 

page 34.





Adding the 
Fabric Strips

Create 2 pieced accents with 
fabric strips and decorative 

stitches using the general direction of 
the Elegant Tradition Stitch Recipe on 
page 32. Each accent piece should fit 
across the table runner as shown in 
the photo and be positioned approxi-
mately 9” from each end.    

Serpentine Borders
1. �Cut border fabrics to create two pieces (9” x 22” each) of each fabric 

for each border (4 total).
2. Fold each strip in half lengthwise.
3. Stitch the shaped edged using the appropriate directions below:

Serpentine Edge for any Sewing Machine
1. �Trace the template on the following page onto paper or template  

plastic, repeating it to fit the short edge of the runner; cut it out. Note: 
It should extend beyond the edges of the runner at this point. 

2. �Place the template on one folded border strip; using a fabric marker, 
trace the curved line.

3. Stitch along the marked line through both layers of fabric.
4. Repeat marking and stitching on the remaining border strips.

Directional Serpentine Edge for artista machines:
1. Attach Sideways Motion Foot #40 
2. �Select Stitch #812; increase the Stitch Length to 5.0mm; this will 

increase the spacing of the serpentine shape.
3. �Align the back edge of Foot #40 with the back edge of the fabric and 

the folded edge of the fabric along the 1” mark on the stitch plate.
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By JILL DANKLEFSEN

Supplies

• �Blank Linen Table Runner - 15” x 
43” (www.allaboutblanks.com). 

• �1/8 yard of three coordinating fabric 
– sample uses “In the Manor”  
collection by Kaye England  
for Benartex 

• �1 yard fabric for serpentine borders 
– ¼ yard for each border piece or  
2 fat quarters of different colors

• �OESD Light Weight Tear-Away  
stabilizer

• �Mettler Poly Sheen Multi-Color 
#9934

• �Mettler 50/3 Silk Finish Cotton 
thread for piecing and blanket 
stitching

• �Patchwork Foot #37

• �Open Embroidery Foot #20/20C

• �Clear Embroidery Foot #39/39C

• �80/12 Microtex needle

• �100/16 Wing needle Note: When 
working with a Wing needle, select 
a natural fiber fabric for best results.

• �Sewing Supplies; scissors; pins; 
Rotary cutter, ruler and mat

A purchased table runner, 
some coordinating 
strips of fabric, and 
a few decorative 

stitches work together 
to dress up your table. 

The unique serpentine border on 
each end is created using the provided 

pattern - or do it the easy way using the 
directional stitching feature of your artista 730 (also 

works with the 200, 185, 180 or Inspiration Plus 1630).



4. �Sew the serpentine stitch on all four folded pieces, keeping the fabric  
parallel to the lines on the sewing table as the fabric is fed sideways.  
Note: Touch Pattern Begin when starting to sew each new strip.

5. �Trim and clip next to 
the serpentine stitch-
ing. Clip about every 
¼” so the curves will lie 
smoothly once the fabric 
is turned.

6. Turn the fabric right 
side out. If you have trimmed and clipped enough, you should 
be able to simply roll the seam between your fingers to get the 
curves to lie nicely. Steam press to smooth the serpentine edge.

Finishing the 
Table Runner
1. �Position two  

layers of  
serpentine  
border together, 
offsetting the 
edges as shown - about ¾” apart. Pin together.

2. �Fold the back layer of the bottom border out of the  
way; the layer folded away will now be referred to as the  
facing. Stitch the top 3 layers of fabric together (2  
layers of the top serpentine border and the top layer of 
the background serpentine border) along the straight 
side. Pin and stitch ¼” seam. Trim excess fabric away 
from the top serpentine border. 

3. �Position combined serpentine borders, right sides 
together, on top of the table runner as shown.

4. �Stitch, being sure to stitch outside of the previous row 
of stitching on the borders.

5. Press seam away from table runner.
6. �Press under the raw edge of the border facing.  

Fold over the front and seam the short edges.  
Trim and turn.

7. Secure the border facing by hand or machine.
8. Decorate with decorative stitches as shown.

ISSUE 23
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through the needle

Denim Spice
• Body Fabric: Lightweight denim 
• ��Tab and Binding Fabric: Kaye England “Spice Market” by Benartex; Binder  

Attachment #84 used on flap; Edgestitch Foot #10/10C on tab
• Flap Fabric: Minkee Gelato by Benartex 
• Thread: YLI Variations 
• Extras: EZ Glitzer® with 3mm Swarovski crystals

Think Minkee
• Body Fabric: Allover Minkee Gelato fabric by Benartex 
• Tab: Ribbon
• Batting: Wool 
• �Trim: Piping made using a serger and the Multi-purpose Foot, then applied to the 

purse using Bulky Overlock Foot #12/12C	
• Extras: Bias binder strip as a zipper pull (made with Binder Attachment #86)

Linen Bound
• Body Fabric: Linen-weave fabric by Kaye England by Benartex
• Tab Fabric: Opulence by Benartex by Paula Nadelstern
• Binding Fabric: Opulence by Benartex by Paula Nadelstern
• Flap: Minkee fabric with embroidery
• Thread: YLI Variations  
• Embellishments: EZ Glitzer® with 3mm Swarovski crystals
• �Trim: Piping made using a serger and the Multi-purpose Foot, then applied to the 

purse using Bulky Overlock Foot #12/12C

Not Just A Dot
• Body Fabric: Baby Genius  by Benartex polka dot quilted fabric 
• Tab Fabric: Gradations by Carol Bryer Fallert variegated quilted 
• Binding Fabric: Opulence by Paula Nadelstern by Bernartex along edge of flap.
• �Trim: Piping made using a serger and the Multi-purpose Foot applied using the #12 Foot.

                       Pearl Envy
                       • Body Fabric: Kaye England “Travels In Time” by Benartex
                       • �Binding: Bias silk ribbon binding along flap using Binder Attachment #84.
                       • �Extras: Silver nail heads and pearl glitz stones applied with the  

EZ Glitzer®.
                       • Hardware: Ri Ri Zipper with suede tie attached to pull

By Vicki Tracy

Available at BERNINA® stores in fall of 2007, this unique embroidery collection is more than 
just decoration! When you stitch the “designs” from In A Clutch, you are actually making 
purses! The collection has one basic purse shape and one coin purse shape. The flaps 
and tabs vary in shape and the stitching within those shapes is different on each one. 
The finishing details can vary greatly and adding the combination of available fabrics and 
threads gives a multitude of possibilities. The size of the purse is limited only by the size of 
the embroidery hoop of your machine! 

The embroidery for the components and the outline stitching for the cutting lines are all 
sewn in the embroidery hoop. Once unhooped and trimmed, there are various ways to put 
the whole thing together using your favorite specialty techniques and presser feet. Avail-
able for all formats, the collection comes with complete directions including an instructional 
DVD. Here are just a few ideas to get you started.

Back of Clutch

In a Clutch






